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Copyright
Copyright © 2008 Nokia. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form
without the prior written permission of Nokia is prohibited.

Nokia, Nokia Connecting People, and Nokia X and Y are trademarks or registered trademarks of Nokia
Corporation. Other product and company names mentioned herein may be trademarks or tradenames of
their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and
improvements to any of the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental,
consequential or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no warranties of
any kind, either express or implied, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this
document. Nokia reserves the right to revise this document or withdraw it at any time without prior notice.

The availability of particular products may vary by region.

IMPORTANT
This document is intended for use by qualified service personnel only.
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Warnings and cautions

Warnings
• IF THE DEVICE CAN BE INSTALLED IN A VEHICLE, CARE MUST BE TAKEN ON INSTALLATION IN VEHICLES FITTED

WITH ELECTRONIC ENGINE MANAGEMENT SYSTEMS AND ANTI-SKID BRAKING SYSTEMS. UNDER CERTAIN FAULT
CONDITIONS, EMITTED RF ENERGY CAN AFFECT THEIR OPERATION. IF NECESSARY, CONSULT THE VEHICLE DEALER/
MANUFACTURER TO DETERMINE THE IMMUNITY OF VEHICLE ELECTRONIC SYSTEMS TO RF ENERGY.

• THE PRODUCT MUST NOT BE OPERATED IN AREAS LIKELY TO CONTAIN POTENTIALLY EXPLOSIVE ATMOSPHERES,
FOR EXAMPLE, PETROL STATIONS (SERVICE STATIONS), BLASTING AREAS ETC.

• OPERATION OF ANY RADIO TRANSMITTING EQUIPMENT, INCLUDING CELLULAR TELEPHONES, MAY INTERFERE
WITH THE FUNCTIONALITY OF INADEQUATELY PROTECTED MEDICAL DEVICES. CONSULT A PHYSICIAN OR THE
MANUFACTURER OF THE MEDICAL DEVICE IF YOU HAVE ANY QUESTIONS. OTHER ELECTRONIC EQUIPMENT MAY
ALSO BE SUBJECT TO INTERFERENCE.

• BEFORE MAKING ANY TEST CONNECTIONS, MAKE SURE YOU HAVE SWITCHED OFF ALL EQUIPMENT.

Cautions
• Servicing and alignment must be undertaken by qualified personnel only.

• Ensure all work is carried out at an anti-static workstation and that an anti-static wrist strap is worn.

• Ensure solder, wire, or foreign matter does not enter the telephone as damage may result.

• Use only approved components as specified in the parts list.

• Ensure all components, modules, screws and insulators are correctly re-fitted after servicing and
alignment.

• Ensure all cables and wires are repositioned correctly.

• Never test a mobile phone WCDMA transmitter with full Tx power, if there is no possibility to perform the
measurements in a good performance RF-shielded room. Even low power WCDMA transmitters may disturb
nearby WCDMA networks and cause problems to 3G cellular phone communication in a wide area.

• During testing never activate the GSM or WCDMA transmitter without a proper antenna load, otherwise
GSM or WCDMA PA may be damaged.
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For your safety

QUALIFIED SERVICE
Only qualified personnel may install or repair phone equipment.

ACCESSORIES AND BATTERIES
Use only approved accessories and batteries. Do not connect incompatible products.

CONNECTING TO OTHER DEVICES
When connecting to any other device, read its user’s guide for detailed safety instructions. Do not connect
incompatible products.
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Care and maintenance
This product is of superior design and craftsmanship and should be treated with care. The suggestions below
will help you to fulfil any warranty obligations and to enjoy this product for many years.

• Keep the phone and all its parts and accessories out of the reach of small children.

• Keep the phone dry. Precipitation, humidity and all types of liquids or moisture can contain minerals that
will corrode electronic circuits.

• Do not use or store the phone in dusty, dirty areas. Its moving parts can be damaged.

• Do not store the phone in hot areas. High temperatures can shorten the life of electronic devices, damage
batteries, and warp or melt certain plastics.

• Do not store the phone in cold areas. When it warms up (to its normal temperature), moisture can form
inside, which may damage electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the phone.

• Do not paint the phone. Paint can clog the moving parts and prevent proper operation.

• Use only the supplied or an approved replacement antenna. Unauthorised antennas, modifications or
attachments could damage the phone and may violate regulations governing radio devices.

All of the above suggestions apply equally to the product, battery, charger or any accessory.
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ESD protection
Nokia requires that service points have sufficient ESD protection (against static electricity) when servicing
the phone.

Any product of which the covers are removed must be handled with ESD protection. The SIM card can be
replaced without ESD protection if the product is otherwise ready for use.

To replace the covers ESD protection must be applied.

All electronic parts of the product are susceptible to ESD. Resistors, too, can be damaged by static electricity
discharge.

All ESD sensitive parts must be packed in metallized protective bags during shipping and handling outside
any ESD Protected Area (EPA).

Every repair action involving opening the product or handling the product components must be done under
ESD protection.

ESD protected spare part packages MUST NOT be opened/closed out of an ESD Protected Area.

For more information and local requirements about ESD protection and ESD Protected Area, contact your local
Nokia After Market Services representative.
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Battery information
Note: A new battery's full performance is achieved only after two or three complete charge and
discharge cycles!

The battery can be charged and discharged hundreds of times but it will eventually wear out. When the
operating time (talk-time and standby time) is noticeably shorter than normal, it is time to buy a new battery.

Use only batteries approved by the phone manufacturer and recharge the battery only with the chargers
approved by the manufacturer. Unplug the charger when not in use. Do not leave the battery connected to
a charger for longer than a week, since overcharging may shorten its lifetime. If left unused a fully charged
battery will discharge itself over time.

Temperature extremes can affect the ability of your battery to charge.

For good operation times with Ni-Cd/NiMh batteries, discharge the battery from time to time by leaving the
product switched on until it turns itself off (or by using the battery discharge facility of any approved accessory
available for the product). Do not attempt to discharge the battery by any other means.

Use the battery only for its intended purpose.

Never use any charger or battery which is damaged.

Do not short-circuit the battery. Accidental short-circuiting can occur when a metallic object (coin, clip or
pen) causes direct connection of the + and - terminals of the battery (metal strips on the battery) for example
when you carry a spare battery in your pocket or purse. Short-circuiting the terminals may damage the battery
or the connecting object.

Leaving the battery in hot or cold places, such as in a closed car in summer or winter conditions, will reduce
the capacity and lifetime of the battery. Always try to keep the battery between 15°C and 25°C (59°F and 77°
F). A phone with a hot or cold battery may temporarily not work, even when the battery is fully charged.
Batteries' performance is particularly limited in temperatures well below freezing.

Do not dispose of batteries in a fire!

Dispose of batteries according to local regulations (e.g. recycling). Do not dispose as household waste.
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Company policy
Our policy is of continuous development; details of all technical modifications will be included with service
bulletins.

While every endeavour has been made to ensure the accuracy of this document, some errors may exist. If
any errors are found by the reader, NOKIA MOBILE PHONES Business Group should be notified in writing/e-
mail.

Please state:

• Title of the Document + Issue Number/Date of publication

• Latest Amendment Number (if applicable)

• Page(s) and/or Figure(s) in error

Please send to:
NOKIA CORPORATION

Nokia Mobile Phones Business Group

Nokia Customer Care

PO Box 86

FIN-24101 SALO

Finland

E-mail: Service.Manuals@nokia.com
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Nokia 5130 Service Manual Structure
1 General information
2 Service Devices and Service Concepts
3 BB Troubleshooting and Manual Tuning Guide
4 RF troubleshooting
5 System Module
Glossary
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 Product selection
RM-495/496 (Nokia 5130) is a GSM quad band phone, supporting GSM850/900/1800/1900 bands.

Figure 1 RM-495/496 (Nokia 5130) product picture

 Phone features

Display and keypad features
• 2” 240x320 pixel, 262k true colour display

• 5-way , navi-key (2 soft-keys, call and end keys)

Hardware features
• 2-megapixel camera with 4x digital zoom

• 3.5mm AV connector for stereo headset

• Micro USB port for data transfer (USB 2.0)

• Bluetooth (version 2.0)

• RDS Stereo radio and music player

• Internal vibrator and antenna

• Plug-in SIM (1.8 V and 3.0 V)

• MicroSD card hot swap slot (up to 8GB)

• Dedicated music keys (play/pause/forward)

• STDAC for improved music quality and extended playback time

• Side volume keys with zoom functionality

RF features
• GSM850/900/1800/1900

RM-495; RM-496
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• EGPRS: MSC 32 (MSC 31 in China)

• GPRS: MSC 32 (MSC 31 in China)

• HSCDS

• CSD

 User interface and software features

Selection of software applications and services
• Audio messages

• XHTML browsing over TCP/IP

• Themes (wallpapers, icons, colors)

• Music Player supporting MP3, AAC, ACC+, eAAC+ and WMA

• Nokia Xpress audio messaging (AMS)

• OMA DRM 2.0 (Digital Right Management)

• OMA MMS 1.2, MMS Conformance 3.0, AMR and SMIL

• OMA Client Provisioning v1.1

• Java

• MP3 ringing tones, true tones and MIDI ringing, alert and gaming tones with support of 64 polyphony

• Video ringing tones

• WAP 2.0, XHTML browser over HTTP/TCP/IP stack

• SyncML (local and remote)

• TWIN PC Suite

 Accessories

Sales package contents
• Nokia 5130 phone

• Nokia Battery BL-5C

• Nokia Charger: AC-3

(AC-6 and CA-100C for PRC)

• 1GB micro SD memory card (area dependent)

• Nokia wired stereo headset: HS-125

• CD rom

• User Guide

Table 1 Battery and chargers

Type Name

Note: This phone is charged through the smaller charger Nokia standard interface (2.mm plug). The
standard 3.5mm standard charger can be used together with the CA-44 charger adapter.

AC-3 Charger

BL-5C Battery 1020 mAh Li-Ion

RM-495; RM-496
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Table 2 Headsets

Type Name

HS-125 Stereo headset (wired)

HS-62 Stereo headset (wired)

HS-39W Stereo headset (BT)

HS-71W Stereo headset (BT)

Table 3 Data cables

Type Name

CA-101 Micro USB cable

 Technical specifications

General specifications

Unit Dimension (mm) Weight (g) Volume (cc)

Transceiver with BL-5C
1020 mAh Li-Ion battery
pack

107.5X46.7X14.8 88 65

Battery endurance

Battery NMP Talk time NMP Standby time

BL-5C 1020 mAh Li-ion Up to 6.2 Hours 15 Days

Music 20 Hours

Note: Variation in operation times will occur depending on SIM card, network settings and usage.
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 Service devices

Product specific devices
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-495; RM-496. For the correct use of the service devices, and the best effort of workbench
setup, please refer to various concepts.

FS-108 Flash adapter

• FS-108 is equipped with a clip interlock system

• provides standardised interface towards Control Unit

• provides RF connection using coupler

• multiplexing between USB and FBUS media, controlled by VUSB

MJ-215 Module jig

MJ-215 is meant for component level troubleshooting.

The jig includes an RF interface for GSM and Bluetooth. In addition, it
has the following features:

• Provides mechanical interface with the engine module

• Provides galvanic connection to all needed test pads in module

• Multiplexing between USB and FBUS media, controlled by Vusb

• MMC interface

• Duplicated SIM connector

• Connector for control unit

• Access for AV- and USB connectors

RJ-230 Common jig

RJ-230 is a jig used for soldering and as a rework jig for the engine
module.

RM-495; RM-496
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SA-130 RF coupler

SA-130 is an RF coupler for GSM RF testing. It is used together with
SS-46 and SS-62.

The following table shows attenuations from the antenna pads of the
mobile terminal to the SMA connectors of SA-130:

• Band Tuning
channel

Attenuation RX
(dB)

Attenuation
TX(dB)

GSM850 128 8.73 13.85

190 8.23 11.1

251 8.03 10.7

GSM900 38 7.5 7.7

124 6.8 7.1

975 7.3 7.1

GSM1800 512 13.6 15.1

700 14.2 14.6

885 14 15.1

GSM1900 512 14.07 16.8

661 15.72 16.9

810 17.5 16.8

SS-203 Domesheet
alignment jig

SS-203 is used for aligning domesheet to PWB.

General devices
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-495; RM-496. For the correct use of the service devices, and the best effort of workbench
setup, please refer to various concepts.
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CU-4 Control unit

CU-4 is a general service tool used with a module jig and/or a flash
adapter. It requires an external 12 V power supply.

The unit has the following features:

• software controlled via USB

• EM calibration function

• Forwards FBUS/Flashbus traffic to/from terminal

• Forwards USB traffic to/from terminal

• software controlled BSI values

• regulated VBATT voltage

• 2 x USB2.0 connector (Hub)

• FBUS and USB connections supported

When using CU-4, note the special order of connecting cables and
other service equipment:

Instructions
1 Connect a service tool (jig, flash adapter) to CU-4.

2 Connect CU-4 to your PC with a USB cable.

3 Connect supply voltage (12 V)

4 Connect an FBUS cable (if necessary).

5 Start Phoenix service software.

Note: Phoenix enables CU-4 regulators via USB when it is
started.

Reconnecting the power supply requires a Phoenix restart.

RM-495; RM-496
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FLS-5 Flash device

FLS-5 is a dongle and flash device incorporated into one package,
developed specifically for POS use.

Note: FLS-5 can be used as an alternative to PKD-1.

FPS-10 Flash prommer

FPS-10 interfaces with:

• PC

• Control unit

• Flash adapter

• Smart card

FPS-10 flash prommer features:

• Flash functionality for BB5 and DCT-4 terminals

• Smart Card reader for SX-2 or SX-4

• USB traffic forwarding

• USB to FBUS/Flashbus conversion

• LAN to FBUS/Flashbus and USB conversion

• Vusb output switchable by PC command

FPS-10 sales package includes:

• FPS-10 prommer

• Power Supply with 5 country specific cords

• USB cable

Note: FPS-21 is substitute FPS-10 if FPS-10 has not been set
up.

RM-495; RM-496
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FPS-21 Flash prommer

FPS-21 sales package:

• FPS-21 prommer

• AC-35 power supply

• CA-31D USB cable

FPS-21 interfaces:

Front
• Service cable connector

Provides Flashbus, USB and VBAT connections to a mobile device.

• SmartCard socket

A SmartCard is needed to allow DCT-4 generation mobile device
programming.

Rear
• DC power input

For connecting the external power supply (AC-35).

• Two USB A type ports (USB1/USB3)

Can be used, for example, for connecting external storage memory
devices or mobile devices

• One USB B type device connector (USB2)

For connecting a PC.

• Phone connector

Service cable connection for connecting Flashbus/FLA.

• Ethernet RJ45 type socket (LAN)

For connecting the FPS-21 to LAN.

Inside
• Four SD card memory slots

For internal storage memory.

Note: In order to access the SD memory card slots inside
FPS-21, the prommer needs to be opened by removing the
front panel, rear panel and heatsink from the prommer body.

Note: FPS-10 can be used for flashing instead of FPS-21 if
necessary.

PK-1 Software protection
key

PK-1 is a hardware protection key with a USB interface. It has the same
functionality as the PKD-1 series dongle.

PK-1 is meant for use with a PC that does not have a series interface.

To use this USB dongle for security service functions please register
the dongle in the same way as the PKD-1 series dongle.

RM-495; RM-496
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PKD-1 SW security device

SW security device is a piece of hardware enabling the use of the
service software when connected to the parallel (LPT) port of the PC.

Without the device, it is not possible to use the service software.

Printer or any such device can be connected to the PC through the
device if needed.

SB-6 Bluetooth tester

The SB-6 test box is a generic device to perform Bluetooth bit error
rate testing and doing cordless FBUS connection via Bluetooth.

SPS-2 Soldering paste
spreader

SRT-6 Opening tool

SRT-6 is used to open phone covers.

SS-108 Peeling tool

The peeling tool SS-108 is used to peel off the shielding.

RM-495; RM-496
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SS-46 Interface adapter

SS-46 acts as an interface adapter between the flash adapter and
FPS-10.

SS-62 Generic flash adapter
base for BB5

• generic base for flash adapters and couplers

• SS-62 equipped with a clip interlock system

• provides standardised interface towards Control Unit

• provides RF connection using galvanic connector or coupler

• multiplexing between USB and FBUS media, controlled by VUSB

SS-88 Camera removal tool

The camera removal tool SS-88 is used to remove/attach the front
camera module from/to the socket.

SS-93 Blue stick tool

SS-93 is used for general disassembly and assembly tasks.

SX-4 Smart card

SX-4 is a BB5 security device used to protect critical features in tuning
and testing.

SX-4 is also needed together with FPS-10 when DCT-4 phones are
flashed.

Cables
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-495; RM-496. For the correct use of the service devices, and the best effort of workbench
setup, please refer to various concepts.
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CA-101 Micro USB cable

The CA-101 is a USB-to-microUSB data cable that allows connections
between the PC and the phone.

CA-112DS Easy flash II cable

The CA-112DS easy flash II cable is used for connecting phone DC port
to the PROMMER facilities (FLS-5, FPS-20).

CA-35S Power cable

CA-35S is a power cable for connecting, for example, the FPS-10 flash
prommer to the Point-Of-Sales (POS) flash adapter.

RM-495; RM-496
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CA-89DS Cable

Provides VBAT and Flashbus connections to mobile device
programming adapters.

CA-99PS Adapter

CA-99PS adapter, 3.5 jack to 5.5 plug.

PCS-1 Power cable

The PCS-1 power cable (DC) is used with a docking station, a module
jig or a control unit to supply a controlled voltage.
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XCS-4 Modular cable

XCS-4 is a shielded (one specially shielded conductor) modular cable
for flashing and service purposes.

XRE-2 Bluetooth cable

The bluetooth cable connects the bluetooth connector of the module
jig to the bluetooth test box JBT-9.

XRS-6 RF cable

The RF cable is used to connect, for example, a module repair jig to
the RF measurement equipment.

SMA to N-Connector approximately 610 mm.

Attenuation for:

• GSM850/900: 0.3+-0.1 dB

• GSM1800/1900: 0.5+-0.1 dB

• WLAN: 0.6+-0.1dB

RM-495; RM-496
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 Service concepts

POS (Point of Sale) flash concept

Figure 2 POS flash concept

Type Description

Product specific tools

BL-5C Battery

Other tools

FLS-5 POS flash dongle

PC with Phoenix service software

Cables

CA-101 USB connectivity cable
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Flash concept with FPS-10

Figure 3 Basic flash concept with FPS-10

Type Description

Product specific devices

FS-108 Flash adapter

Other devices

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SS-46 Interface adapter

PC with Phoenix service software

Cables

XCS-4 Modular cable

CA-35S Power cable

USB cable
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CU-4 flash concept with FPS-10

Figure 4 CU-4 flash concept with FPS-10

Type Description

Product specific devices

FS-108 Flash adapter

Other devices

CU-4 Control unit

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SS-62 Flash adapter base

SX-4 Smart card

PC with Phoenix service software

Cables

PCS-1 Power cable

XCS-4 Modular cable

Standard USB cable

USB cable
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Module jig service concept

Figure 5 Module jig service concept

Type Description

Phone specific devices

MJ-215 Module jig

Other devices

CU-4 Control unit

FPS-10 Flash prommer box

PK-1 SW security device

SX-4 Smart card

PC with VPOS and Phoenix service software

Measurement equipment

Cables

PCS-1 DC power cable

XCS-4 Modular cable

XRS-6 RF cable

USB cable
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Type Description

GPIB control cable

RF testing concept with RF coupler

Figure 6 RF testing concept with RF coupler

Type Description

Product specific devices

FS-108 Flash adapter

SA-130 RF coupler

Other devices

CU-4 Control unit

SX-4 Smart card

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SS-62 Flash adapter base

Measurement equipment

PC with Phoenix service software

Cables

PCS-1 Power cable
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Type Description

XCS-4 Modular cable

XRS-6 RF cable

GPIB control cable

USB cable

BB5 Basic Flash Concept with FPS-21, SS-46

Figure 7 BB5 Basic Flash Concept with FPS-21, SS-46
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BB5 Basic Flash Concept with FPS-21, SS-62

Figure 8 BB5 Basic Flash Concept with FPS-21, SS-62
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BB5 Basic RF & BB Tune Concept with FS-108

Figure 9 BB5 Basic RF & BB Tune Concept with FS-108
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BB5 Basic RF&BB Tune Concept with MJ-215

Figure 10 BB5 Basic RF&BB Tune Concept with MJ-215
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 Baseband self tests in Phoenix

Context
Always start the troubleshooting procedure by running the Phoenix self tests. If a test fails, please follow the
diagram below.

If the phone is dead and you cannot perform the self tests, go to Dead or jammed device troubleshooting.
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Troubleshooting flow
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 Power and charging troubleshooting

Dead or jammed device troubleshooting

Troubleshooting flow
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Troubleshooting flow
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General power checking
Check the following voltages:

Signal name Regulator Sleep Idle Nominal
voltage

Main user Notes

VIO AVILMA ON ON 1.82 Memory, I/Os,
Display

VBACK AVILMA ON ON 2.5 Back-up
battery

VSIM1 AVILM ON ON 1.8/3.0 SIM card

VDRAM AVILMA ON ON 1.82 SDRAM

VAUX AVILMA OFF OFF 2.5 Camera,
Display

VR1 AVILMA OFF ON 2.5 Crystal
oscillators, RFIC

VRFC AVILMA OFF ON 1.8 RAPs
converters

VRCP1 AVILMA 4.75 To RF parts RF active

VREF AVILMA ON ON 1.35 RF reference

VCORE BETTY ON ON 1.05

1.25

1.35

1.40

Combo
memory

VOUT BETTY OFF OFF 2.5 Accessory
connected

VSIM2 AVILMA OFF OFF 2.2 Internal
microphone

Charging troubleshooting

Troubleshooting flow
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 Interface troubleshooting

Flash programming fault troubleshooting

Part 1
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Part 2

Figure 11 Flashing pic 1. Take single trig measurement for the rise of the BSI signal.
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Figure 12 Flashing pic 2. Take single trig measurement for the rise of the BSI signal.
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Combo memory troubleshooting

Troubleshooting flow
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USB interface troubleshooting

Troubleshooting flow
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SIM card troubleshooting

Troubleshooting flow
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 User interface troubleshooting

Keypad troubleshooting

Context
There are two possible failure modes in the keyboard module:

• One or more keys are stuck, so that the key does not react when a keydome is pressed. This kind of failure
is caused by mechanical reasons (dirt, rust, mechanical damage, etc.)

• Malfunction of several keys at the same time; this happens when one or more rows or columns in the key
matrix are failing (shortcut or open connection).

If the failure mode is not clear, start with the Keyboard test in Phoenix.
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Troubleshooting flow
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Display module troubleshooting

General instructions for display troubleshooting

Context
• The display is in a normal mode when the phone is in active use.

• Display is in a partial idle mode when the phone is in the screen saver mode.

• The operating modes of the display can be controlled with the help of Phoenix.

Table 4 Display module troubleshooting cases

Display blank There is no image on the display. The display looks
the same when the phone is on as it does when the
phone is off. The backlight can be on in some cases.

Image on the display not correct Image on the display can be corrupted or a part of
the image can be missing. If a part of the image is
missing, change the display module. If the image is
otherwise corrupted, follow the appropriate
troubleshooting diagram.

Visual defects (pixel) Pixel defects can be checked by controlling the
display with Phoenix. Use both colours, black and
white, on a full screen.

The display may have some random pixel defects
that are acceptable for this type of display. The
criteria when pixel defects are regarded as a display
failure, resulting in a replacement of the display, are
presented the following table.

Table 5 Pixel defects

Item White dot defect Black dot
defect

Total

1 Defect
counts

R G B White
Dot
Total

1 1

1 1 1 1

2 Combine
d defect
counts

Not allowed.

Two single dot defects that are within 5 mm of each other should
be interpreted as combined dot defect.
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Display troubleshooting

Troubleshooting flow

RM-495; RM-496
BB Troubleshooting and Manual Tuning Guide

Issue 1 COMPANY CONFIDENTIAL Page 3 –21
Copyright © 2008 Nokia. All rights reserved.



Keyboard backlight troubleshooting

Troubleshooting flow
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Music sidekey troubleshooting

Troubleshooting flow
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SD card troubleshooting

Troubleshooting flow
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 Camera troubleshooting

Camera troubleshooting

Troubleshooting flow
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 Audio troubleshooting

Audio troubleshooting test instructions
Differential external earpiece and internal earpiece outputs can be measured either with a single-ended or
a differential probe.

When measuring with a single-ended probe each output is measured against the ground.

Internal handsfree output is measured using a current probe, if a special low-pass filter designed for
measuring a digital amplifier is not available. Note also that when using a current probe, the input signal
frequency must be set to 2kHz.

The input signal for each loop test can be either single-ended or differential.

Required equipment
The following equipment is needed for the tests:

• Oscilloscope

• Function generator (sine waveform)

• 'Active speaker' or 'speaker and power amplifier'

• Sound level meter

• Current probe (Internal handsfree DPMA output measurement)

• Phoenix service software

• Battery voltage 3.7V

Test procedure
Audio can be tested using the Phoenix audio routings option. Three different audio loop paths can be
activated:

• External microphone to Internal earpiece

• External microphone to Internal handsfree speaker

• Internal microphone to External earpiece

Each audio loop sets routing from the specified input to the specified output enabling a quick in-out test.
Loop path gains are fixed and they cannot be changed using Phoenix. Correct pins and signals for each test
are presented in the following table.

Phoenix audio loop tests and test results
The results presented in the table apply when no accessory is connected and battery voltage is set to 3.7V.

Earpiece, internal microphone and speaker are in place during measurement. Applying a headset accessory
during measurement causes a significant drop in measured quantities.

The gain values presented in the table apply for a differential output vs. single-ended/differential input.
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Loop test Input
terminal

Output
terminal

Path
gain [dB]

(fixed)

Input
voltage
[mVp-p]

Differential
output
voltage
[mVp-p]

Output
DC level

[V]

Output
current

[mA]

External Mic to
External Earpiece

XMICP and
GND

HSEAR R P,
HSEAR R N
and GND

-2.9 1000 720 1.2 NA

HSEAR P,
HSEAR N
and GND

XMICN and
GND

HSEAR R P,
HSEAR R N
and GND

HSEAR P,
HSEAR N
and GND

External Mic to
Internal Earpiece

XMICP and
GND

EarP and
GND

-4.5 1000 600 1.2 NA

EarN and
GND

XMICN and
GND

EarP and
GND

EarN and
GND

External Mic to
Internal
handsfree

XMICP and
GND

B2102 pads -5 1000 560 0 25mA
(calc.)

XMICN and
GND

B2102 pads

Internal Mic to
External Earpiece

B2100
(OUT/GND)

HSEAR R P,
HSEAR R N
and GND

22.7 100 1360 1.2 NA

HSEAR P,
HSEAR N
and GND

HSEAR R P,
HSEAR R N
and GND

HSEAR P,
HSEAR N
and GND
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Measurement data

Figure 13 Single-ended output waveform of the Ext_in_HP_out measurement when earpiece is connected.

If a special low-pass filter designed for measuring digital amplifiers is unavailable, the measurement must be performed with a
current probe and the input signal frequency must be 2kHz.

Figure 14 Differential output waveform of the Ext_in_IHF_out out loop measurement when speaker is connected.
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Figure 15 Single-ended output waveform of the HP_in_Ext_out loop when microphone is connected.
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Internal earpiece troubleshooting

Troubleshooting flow
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Internal microphone troubleshooting

Troubleshooting flow
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Internal handsfree (IHF) troubleshooting

Troubleshooting flow
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External earpiece troubleshooting

Troubleshooting flow
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External microphone troubleshooting

Troubleshooting flow
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Vibra troubleshooting

Troubleshooting flow
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 Baseband manual tuning guide

Certificate restoring for BB5 products

Context
This procedure is performed when the device certificate is corrupted for some reason.

All tunings (RF & Baseband, UI) must be done after performing the certificate restoring procedure.

The procedure for certificate restoring is the following:

• Flash the phone with the latest available software using FPS-8 or FPS-10.

Note: USB flashing does not work for a dead BB5 phone.

• Create a request file.

• Send the file to Nokia by e-mail. Use the following addresses depending on your location:

• APAC: sydney.service@nokia.com

• CHINA: repair.ams@nokia.com

• E&A: salo.repair@nokia.com

• AMERICAS: fls1.usa@nokia.com

• When you receive a reply from Nokia, carry out certificate restoring.

• Tune the phone completely.

Note: SX-4 smart card is needed.

• If the phone resets after certificate restoring, reflash the phone again.

Required equipment and setup:

• Phoenix service software v 2007.19 or newer.

• The latest phone model specific Phoenix data package.

• PKD-1 dongle

• SX-4 smart card (Enables BB5 testing and tuning features)

• External smart card reader

Note: The smart card reader is only needed when FPS-8 is used. FPS-10 has an integrated smart card
reader.

• Activated FPS-8 flash prommer OR FPS-10 flash prommer

• Flash update package 03.18.004 or newer for FPS-8 or FPS-10 flash prommers

• CU-4 control unit

• USB cable from PC USB Port to CU-4 control unit

• Phone model specific adapter for CU-4 control unit

• PCS-1 cable to power CU-4 from external power supply

• XCS-4 modular cable between flash prommer and CU-4

Note: CU-4 must be supplied with +12 V from an external power supply in all steps of certificate
restoring.

Steps
1. Program the phone software.

i Start Phoenix and login. Make sure the connection has been managed correctly for FPS-8 or FPS-10.
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ii Update the phone MCU software to the latest available version.

If the new flash is empty and the phone cannot communicate with Phoenix, reflash the phone.

iii Choose the product manually from File→Open Product , and click OK.

Wait for the phone type designator (e.g. “RM-1” ) to be displayed in the status bar.

iv Go to Flashing→SW Update  and wait until Phoenix reads the product data as shown in the following
picture.

Product is automatically set according to the phone support module which was opened manually,
but the flash files cannot be found because the correct data cannot be read from the phone
automatically.

Code must be chosen manually, it determines the correct flash files to be used. Please choose the
correct product code (can be seen in the phone type label) from the dropdown list.

Flash Type must be set to Phone as Manufactured.

v To continue, click Start.

Progress bars and messages on the screen show actions during phone programming, please wait.
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Programming is completed when Flashing Completed message is displayed.

The product type designator and MCU SW version are displayed in the status bar.

vi Close the SW Update window and then choose File→Close Product .

2. Create a Request file.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i To connect the phone with Phoenix, choose File→Scan Product .

ii Choose Tools→Certificate Restore .

iii To choose a location for the request file, click Browse.
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iv Name the file so that you can easily identify it, and click Open.

The name of the file and its location are shown.

v To create the Request file, click Start.

vi When the file for certificate restore has been created, send it to Nokia as an e-mail attachment.

3. Restore certificate.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i Save the reply file sent by Nokia to your computer.

ii Start Phoenix service software.

iii Choose File→Scan Product .
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iv From the Tools menu, choose Certificate Restore and select Process a response file in the Action
pane.

v To choose the location where response file is saved, click Browse.

vi Click Open.

The name of the file and the path where it is located are shown.

vii To write the file to phone, click Start.

Next actions
After a successful rewrite, you must retune the phone completely by using Phoenix tuning functions.

Important: Perform all tunings: RF, BB, and UI.
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Energy management calibration

Prerequisites
Energy Management (EM) calibration is performed to calibrate the setting (gain and offset) of AD converters
in several channels (that is, battery voltage, BSI, battery current) to get an accurate AD conversion result.

Hardware setup:

• An external power supply is needed.

• Supply 12V DC from an external power supply to CU-4 to power up the phone.

• The phone must be connected to a CU-4 control unit with a product-specific flash adapter.

Steps
1. Place the phone to the docking station adapter (CU-4 is connected to the adapter).

2. Start Phoenix service software.

3. Choose File→ Scan Product.

4. Choose Tuning→Energy Management Calibration.

5. To show the current values in the phone memory, click Read, and check that communication between
the phone and CU-4 works.

6. Check that the CU-4 used check box is checked.

7. Select the item(s) to be calibrated.

Note: ADC calibration has to be performed before other item(s). However, if all calibrations are
selected at the same time, there is no need to perform the ADC calibration first.

8. Click Calibrate.

The calibration of the selected item(s) is carried out automatically.

The candidates for the new calibration values are shown in the Calculated values column. If the new
calibration values seem to be acceptable (please refer to the following "Calibration value limits" table),
click Write to store the new calibration values to the phone permanent memory.

Table 6 Calibration value limits

Parameter Min. Max.

ADC Offset -20 20

ADC Gain 12000 14000

BSI Gain 1100 1300

VBAT Offset 2400 2650

VBAT Gain 19000 23000

VCHAR Gain N/A N/A

IBAT (ICal) Gain 7750 12250

9. Click Read, and confirm that the new calibration values are stored in the phone memory correctly. If the
values are not stored to the phone memory, click Write and/or repeat the procedure again.

10. To end the procedure, close the Energy Management Calibration window.
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 General RF troubleshooting

Introduction to RF troubleshooting

Troubleshooting process
RF troubleshooting is performed in this order:

1 Autotuning

2 General power checking

3 Selftests

4 RX and TX troubleshootings

Most RF semiconductors are static discharge sensitive
ESD protection must be applied during repair (ground straps and ESD soldering irons).

Pre-baking
These parts are moisture sensitive and must be pre-baked prior to soldering:

• RFIC N1001

• Front End Module (FEM) N1002

Discrete components
In addition to the two key-components, there are few number of discrete components (capacitors and
inductors) for which troubleshooting is done mainly by visual inspection.

Capacitors: check for short circuits.

Note: In-circuit measurements should be evaluated carefully

Measuring equipment
All measurements should be done using:

• An oscilloscope for low frequency and DC measurements. Recommended probe: 10:1, 10Mohm//8pF.

• A radio communication tester including RF generator and spectrum analyser, for example Rohde & Schwarz
CMU200. (Alternatively a spectrum analyser and an RF generator can be used. Some tests in this guide are
not possible to perform if this solution is chosen).

Note: All measurements with an RF coupler should be performed in an RF-shielded environment
because nearby base stations can disturb sensitive receiver measurements. If there is no possibility
to use RF shielded environment, testing at frequencies of nearby base stations should be avoided.

Level of repair
The scope of this guideline is to enable repairs at key-component level. Please refer to the troubleshooting
instructions for further information.

RM-495; RM-496
RF troubleshooting

Issue 1 COMPANY CONFIDENTIAL Page 4 –5
Copyright © 2008 Nokia. All rights reserved.



RF key components

Figure 16 RF key components

 Auto tuning for RF

This phone can be tuned automatically.

Autotune is designed to align the phone's RF part easier and faster. It performs calibrations, tunings and
measurements of RX and TX. The results are displayed and logged in a result file, if initiated.

Hardware set up
Hardware requirements for auto tuning:

• PC (Windows 2000/XP) with GPIB card

• Power supply

• Product specific module jig

• Cables: XRS-6 (RF cable), USB cable, GBIP cable and DAU-9S

• Signal analyser (TX), signal generator (RX) and RF-splitter or one device including all.

Figure 17 Auto tuning concept with CMU200

Phoenix preparations
Install the phone specific data package, for example RM-495_dp_1.78_sw_sh3.26.exe. This defines phone
specific settings.
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Auto tuning procedure
1 Make sure the phone (in the jig) is connected to the equipment. Else, some menus will not be shown in

Phoenix.

2 To go to autotune, select Tuning (Alt-U) > Auto-Tune (Alt-A) from the menu.

3 Start autotuning, clicking the Tune button.

 General voltage checking

Steps
1. Set up the main board in the module jig. The phone should be in local mode.

2. Check the following:

# Signal name Test point Voltage (all bands)

1 Vbat at N1002 (FEM) J2903 3.0-4.7 V

2 Vbat at N1001 (Transceiver) C2070 3.0-4.7 V

3 VCCXO supply C2213 2.4-2.6 V
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Figure 18 General voltage checking test points (main board, both sides)

 Selftest troubleshooting

RF selftests

Prerequisites
Do a hardware initialization before you start the selftests:

Testing→GSM→RF Controls→ RX  and then press Stop.

Context
Note: The RF connector should be terminated to 50 Ohms or connected to the antenna. Check this
carefully before performing the self tests.
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Note: The phone should be in local mode when performing Self tests

Steps
1. Check the tests shown in the figure below: Testing→ Self Tests , and press the Start button.

2. A test is either Passed or Fatal. If Fatal continue the selftest troubleshooting. If Passed continue with the
other RF troubleshootings.

3. If Fatal, press Details to see error codes

Error codes will now show up in the right most column marked Detailed.
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Note: The Error Code contains the two first words: 0x00 and0xC0.

Fatal selftests troubleshooting
If a self test is fatal, check the Details→Error code  and follow the instructions below.

Note: If ST_CDSP_RF_BB_IF_TEST is fatal, the other self tests will also be fatal. Always start
troubleshooting ST_CDSP_RF_BB_IF_TEST.
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Figure 19 Testpoints used after fatal self tests

ST_CDSP_RF_BB_IF_TEST is fatal
This test is checking the communication between baseband and RF. It will show in what part the problem is
located.
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Error code Test Action

ST_RFBUS_WRITE_READ_FAIL
(0x00, 0x40) or combination
(0x00, 0xC0)

In Phoenix Testing→ GSM→ RF Controls→RX

Probe:

1 J2805 SDATA (Ch1) [1]

2 J2806 ENX (Ch2) [2]

3 J2804 SCLK (Ch3) [3]

The result should look like this:

Figure 20 Settings: Time 1ns/d + 0.1Vpp/d

All OK: replace N1001

NOK : go to BB
troubleshooting

ST_TXFIFO_WRITE_READ_FAIL
(0x00, 0x80)

In Phoenix: Testing→ GSM→ RF Controls→TX

Probe:

1 J2210 TXBB_CLK (Ch1) [4]

2 J2212 TXBB_DATA (Ch2) [5]

3 J2902 STROBE (Ch3) [6]

The result should look like this:

Figure 21 Settings: Time 1ns/d + 0.3Vpp/d

All OK: replace N1001

NOK : go to BB
troubleshooting
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ST_CDSP_GSM_TX_POWER_TEST is fatal
This test is checking power amplifier functionality.

Error code Test Action

ST_GSM1800_TX_PWR_LOW
(0x00, 0x02)

ST_GSM850_TX_PWR_LOW
(0x00, 0x08)

Or combination (0x00, 0x0A)

- Replace N1002

ST_TXDAC_FAIL (0x00, 0x10)

Or combination (0x00, 0x1A),
(0x00, 0x12), (0x00, 0x18)

- Replace N1001

ST_CDSP_TX_PLL_PHASE_LOCK_TEST is fatal
This test is checking if phase lock loop is working.

Error code Test Action

ST_TX_PLL_FAIL (0x00, 0x08) Replace N1001

ST_CDSP_RX_IQ_LOOP_BACK_TEST is fatal
This test is checking the analogue RX communication between baseband and RF.

Error code Test Action

ST_FIMRCAL_FAIL (0x00, 0x40)
or combination (0x00, 0x50)
and (0x00, 0x60)

Replace N1001
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Error code Test Action

ST_IQ_POWER_TOO_SMALL
(0x00, 0x10)

ST_IQ_POWER_TOO_HIGH
(0x00, 0x20)

In Phoenix: Testing→ GSM→ RF Controls→RX

Apply -80dBm signal at 948.06771 MHz

Probe during RX operation:

1 J2810 RXIP [7]

2 J2811 RXIN [8]

3 J2812 RXQP (Ch1) [9]

4 J2813 RXQN [10]

5 J2814 ADC_ref [11]

Check voltage level between 0.7-0.8V

The result should look like this:

Figure 22 Frequency ~ 100kHz

All OK : go to BB
troubleshooting

NOK: replace N1001

ST_CDSP_RF_SUPPLY_TEST is fatal
This test is checking internal voltage regulators.

Error code Test Action

ST_VREG_LDO2 (0x20, 0x00)

ST_VREG_VCCXO (0x80, 0x00)

Or combination (0xA0, 0x00)

Check

1 VCCXO value at testpoint E2909 = 2 .4 – 2.6 V
[12]

2 2. VBat = 3.0 – 4.7 V

All OK: replace N1001

NOK : go to power
troubleshooting

 Receiver troubleshooting

Introduction to receiver (RX) troubleshooting
RX can be tested by making a phone call or in local mode. For the local mode testing, use Phoenix service
software.
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The main RX troubleshooting measurement is RSSI reading. This test measures the signal strength of the
received signal. For GSM RSSI measurements, see GSM RX chain activation for manual measurements/GSM
RSSI measurement.

GSM RX chain activation for manual measurements/GSM RSSI measurement

Prerequisites
Make the following settings in Phoenix service software and in the signal generator:

Setting GSM850 GSM900 GSM1800 GSM1900

Phoenix Channel 190 37 700 661

Signal generator
to antenna
connector

881.66771 MHz
(67.71kHz offset)
at -60dBm

942.46771 MHz
(67.71kHz offset)
at -60dBm

1842.86771 MHz
(67.71kHz offset)
at -60dBm

1960.06771 MHz
(67.71kHz offset)
at -60dBm

Steps
1. Set the phone to local mode.

2. Activate RSSI reading in Phoenix (Testing→GSM→RSSI reading )

Results
With the Measuring mode set to Sum vector, the reading should reflect the level of the signal generator (-
losses) +/- 5 dB.

When varying the level in the range -30 to -102 dBm the reading should then follow within +/-5 dB.

Now select the measuring mode to Q branch and I Branch. In each case the reading should be 3 dB below
the signal generator level.

Next actions
RSSI-reading AND TX troubleshooting is failing: replace N1002.

TX is OK and RX is failing: replace N1001.
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 Transmitter troubleshooting

General instructions for transmitter (TX) troubleshooting
Please note the following before performing transmitter tests:

• TX troubleshooting requires TX operation.

• Do not transmit on frequencies that are in use!

• The transmitter can be controlled in local mode for diagnostic purposes.

• The most useful Phoenix tool for GSM transmitter testing is “RF Controls”.

• Remember that re-tuning is not a fix! Phones are tuned correctly in production

Note: Never activate the GSM transmitter without a proper antenna load. Always connect a 50 Ω
load to the RF connector (antenna, RF-measurement equipment or at least a 2 W dummy load);
otherwise the power amplifier may be damaged.

GSM transmitter troubleshooting

Steps
1. Set the phone to local mode.

2. Activate RF controls in Phoenix (Testing→GSM→Rf Controls ).

Make settings as shown in the picture:

RM-495; RM-496
RF troubleshooting

Page 4 –16 COMPANY CONFIDENTIAL Issue 1
Copyright © 2008 Nokia. All rights reserved.



3. Check the basic TX parameters (i.e. power, phase error, modulation and switching spectrum), using a
communication analyser (for example CMU200).

Figure 23 Typical readings
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4. Change power level (RF controls) and make sure the power reading follows accordingly.

Next actions
TX is failing and RX is OK: replace N1002

If you want to troubleshoot the other bands, change band with RF controls and set the communication
analyzer accordingly.

 Bluetooth and FM radio troubleshooting

Bluetooth troubleshooting

Troubleshooting flow

Figure 24 Troubleshooting diagram: Bluetooth
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FM radio troubleshooting

Troubleshooting flow
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 Introduction

Phone description
RAP is the main digital baseband ASIC in the phone. It contains functionality for GSM EDGE. The hardware
accelerator is used as a camera accelerator.

N2200 (AVILMA) is mainly the audio ASIC in the phone and N2300 (BETTY) is basically the energy management
controller for the phone.

Key components

Function Description Item ref

Main board 2ug

Energy management ASIC AVILMA

BETTY

N2200

N2300

RF ASIC RF IC N1001

Processor RAPS_V3.03-PA D2800

PA GSM Front end module (FEM), quad band N1002

Memory 512 Mbit NOR + 256 Mbit DRAM Combo (Stacked with RAP) D3000

Bluetooth BCM2048 N6000

Battery BL-5C 1020mAh

Battery connector Lynx interface X2070

µUSB connector For data, support USB full speed AV flex:
X2002

Key component placement
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System module block diagram

Board and module connections
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 Energy management

Battery and charging

BL-5C battery
The phone is powered by a 3-pole BL-5C 1020 mAh battery. The three poles are named VBAT, BSI and GND
where the BSI line is used to recognize the battery capacity. This is done by means of an internal battery pull
down resistor.

Figure 25 Battery pin order
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The battery temperature can be measured from the UI flex.

Battery connector
The battery connector is a blade connector. It has three blades;

• BSI (Battery size indicator)

• GND (Ground)

• VBAT (Battery voltage)

The BSI line is used to recognize the battery capacity by a battery internal pull down resistor.

Figure 26 Battery connector

Charging
This phone is charged through a separate charger connector.

Charging is controlled by energy management, and external components are needed to protect the baseband
module against EMC, reverse polarity and transient frequency deviation.

Normal and extreme voltages
Energy management is mainly carried out in the two Application Specific Integrated Circuits (ASICs) N2300
BETTY and N2200 AVILMA. These two circuits contains a number of regulators. In addition there are some
external regulators too.

In the table below normal and extreme voltages are shown when a BL-5C battery is used.

Table 7 Nominal voltages

Voltage Voltage [V] Condition

General Conditions

Nominal voltage 4.0

Lower extreme voltage 3.145

Higher extreme voltage (fast
charging) 4.230

HW Shutdown Voltages

Vmstr+ 2.1 ± 0.1 Off to on

Vmstr- 1.9 ± 0.1 On to off

SW Shutdown Voltages

Sw shutdown 3.106 In call

Sw shutdown 3.2 In idle
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Voltage Voltage [V] Condition

Min Operating Voltage

Vcoff+ 2.9 ± 0.1 Off to on

Vcoff- 2.6 ± 0.1 On to off

Power key and system power-up
When the battery is placed in the phone the power key circuits are energized. When the power key is pressed,
the system boots up (if an adequate battery voltage is present).

Power down can be initiated by pressing the power key again (the system is powered down with the aid of
SW). The power key is connected to EM ASIC N2200 (AVILMA) via PWRONX signal.

Modes of operation

Mode Description

NO_SUPPLY (dead) mode means that the main battery is not present or its voltage is too low (below
N2200 AVILMA master reset threshold) and that the back-up battery voltage is too low.

BACK_UP The main battery is not present or its voltage is too low but back-up battery voltage is
adequate and the 32 kHz oscillator is running (RTC is on).

PWR_OFF In this mode (warm), the main battery is present and its voltage is over N2300 BETTY
master reset threshold. All regulators are disabled, PurX is on low state, the RTC is on
and the oscillator is on. PWR_OFF (cold) mode is almost the same as PWR_OFF (warm),
but the RTC and the oscillator are off.

RESET RESET mode is a synonym for start-up sequence. RESET mode uses 32 kHz clock to count
the REST mode delay (typically 16ms).

SLEEP SLEEP mode is entered only from PWR_ON mode with the aid of SW when the system’s
activity is low.

FLASHING FLASHING mode is for SW downloading.

 USB, SIM, µSD

Micro USB interface
The micro USB (Universal Serial Bus) provides a wired connectivity between a PC and peripheral devices. It is
a differential serial bus.

USB 2.0 is supported with full speed (12 Mbps).

Hot swap is supported, which means that USB devices may be plugged in/out at any time.

This phone is provided with a specific connector for µUSB.
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SIM interface
The device has one SIM (Subscriber Identification Module) interface. It is only accessible if battery is removed.
The SIM interface consists of an internal interface between RAP and EM ASIC AVILMA (N2200), and of an external
interface between N2200 and SIM contacts.

The SIM IF is shown in the following figure:

Figure 27 SIM interface

The EM ASIC AVILMA handles the detection of the SIM card. The detection method is based in the BSI line.
Because of the location of the SIM card, removing the battery causes a quick power down of the SIM interface.

The SIM interface supports both 1.8 V and 3.0 V SIM cards. The SIM interface voltage is first 1.8 V when the
SIM card is inserted, and if the card does not response to the ATR a 3 V interface voltage is used.

µSD card interface

The µSD card is connected to the engine by an external level shifter and ESD protection filter. Supplied
voltages:
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• VMMC: 2.85 V (from level shifter)

• VIO: 1.8 V (from AVILMA)

The card removal is detected by a push detect switch.

 User interface

Display module
The interconnection between the LCD module and the engine is implemented with a 24-pin board-to-board
connector.

The LCD module does not require any tuning in service.

Keyboard

Table 8 Key signal matrix

GENIO ROW Col_0
(GENIO-39)

Col_1
(GENIO-40)

Col_2
(GENIO-41)

Col_3
(GENIO-42)

Col_4
(GENIO-43)

32 ROW0 Left SK Left Right SK Right Volume +

33 ROW1 Send UP Action Down Volume -

34 ROW2 1 4 7 * Forward

35 ROW3 2 5 8 0 Start/Stop

36 ROW4 3 6 9 # Rewind

Backlight and illumination
There is backlight illuminating for the display consisting of 2 LEDs.

The keypad is side lit by 4 LEDs with film lightguide.

The sidekey is top lit by 3 LEDs.
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 Audio concept
This phone has a conventional solution on earpiece and vibra. Both are handled by AVILMA N2200. Two
integrated handsfree speakers are driven by an additional amplifier also handled by AVILMA. The microphone
has a digital interface and its RF-filtered lines are directly connected to RAP D2800 for processing.

Since this phone has focus on audio playback, it contains improved circuits for audio handling. The STDAC is
a D/A-converter that offers better signal to noise ratio than conventional circuits. This improves the playback
audio quality significantly. The playback audio (e.g. music stored in the phone or on the micro USB) is
processed from RAP D2800 via STDAC and an amplifier to the AV-connector (for e.g. headset). The STDAC
contains a FIFO memory that can store up to 85ms of playback time (allowing D2800 to go to sleep mode
and save energy). The entire audio playback circuits are optimized to save energy and improve audio quality
and the energy saving is quite significant (more than 50%, which means longer playback time than in a
conventional design).

Figure 28 Audio block diagram

The Plug detector (PLUG_DET) in the AV connector enables the external microphone, when the phone function
is used. The headset earphones will still be processed via STDAC (without using the power saving mode). The
audio quality will to some extent be improved (saying other links in the audio chain doesn't have the same
high quality as the playback channel has).
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 AV connector
The AV connector is used to connect headsets both in the handsfree phone function and for using the phone
as a media player (see the audio concept heading). The six pins are used in accordance with the table below.

A connected male connector is detected on pin 6 (PLUG_DET).

Note: Only use an approved cable for connecting to the AV connector ( e.g. headset HS-125).

Table 9 AV connector pins

Pin Signal name Direction Description

1, 2 HS_ GND - Ground)

3 HS_MIC Input Microphone

4 HS_EAR_R Output Audio out
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Pin Signal name Direction Description

5 HS_EAR_L Output Audio out

6 PLUG_DET Input Plug detection

 RF description

Receiver (RX)
An analogue signal is received by the phone's antenna. The signal is converted to a digital signal and is then
transferred further to the baseband (eg. to the earpiece).

The receiver functions are implemented in the RF ASIC.

Signals with different frequencies take different paths, therefore being handled by different components.

Transmitter (TX)
The digital baseband signal (eg. from the microphone) is converted to an analogue signal, which is then
amplified and transmitted from the antenna. The frequency of this signal can be tuned to match the
bandwidth of the system in use (eg. GSM900).

The transmitter functions are implemented in the RF ASIC.
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Bluetooth
Bluetooth provides a fully digital link for communication between a master unit (the phone) and one or more
slave units (e.g. a wireless headset). Data and control interface for a low power RF module is provided by the
module.

Figure 29 Bluetooth interface

The Bluetooth has a separate built in antenna and is powered by VBAT and the regulated voltage VIO. For
audio applications the Bluetooth has a PCM data bus. In addition a UART (universal asynchronous receiver/
transmitter) is used for data communication and controls.

 Technical specifications

Main RF characteristics for GSM band phone

Parameter Unit

Cellular system EGSM850/900/1800/1900
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Parameter Unit

RX frequency band EGSM850: 869- 894 MHz

EGSM900: 925- 960 MHz

GSM1800: 1805 - 1880 MHz

GSM1900: 1930 - 1990 MHz

TX frequency band GSM850: 824- 849 MHz

GSM900: 880- 915 MHz

GSM1800: 1710 - 1785 MHz

GSM1900: 1850 - 1910 MHz

Output power GSM850: +5 ... +32.4 dBm

EGSM900: +5 … +32.4 dBm

GSM1800: +0 … +30.3 dBm

GSM1900: +0 ... +30.3 dBm

Number of RF channels GSM850: 124

EGSM900: 172

GSM1800: 375

GSM1900: 300

Channel spacing GSM 200 KHz

Number of Tx power levels GSM850: 15

GSM900: 15

GSM1800: 16

GSM1900: 16

Environmental conditions

Environmental
condition

Ambient temperature Notes

Normal operation -15 oC ... +55 oC Specifications fulfilled

Reduced performance 55 oC ... +70 oC Operational only for short periods

Intermittent or no
operation

-40 oC ... -15 oC and +70 oC ... +85oC Operation not guaranteed but an
attempt to operate will not damage
the phone

No operation or
storage

<-40 oC and >+85 oC No storage. An attempt to operate
may cause permanent damage

Charging allowed -15 oC ... +55 oC

Long term storage
conditions

0 oC ... +85 oC
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Environmental
condition

Ambient temperature Notes

Humidity and water
resistance

Relative humidity range is 5 to 95%.

Condensed or dripping water may
cause intermittent malfunctions.

Protection against dripping water
has to be implemented in (enclosure)
mechanics.

Continuous dampness will cause
permanent damage to the module.
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A/D-converter Analogue-to-digital converter

ACI Accessory Control Interface

ADC Analogue-to-digital converter

ADSP Application DPS (expected to run high level tasks)

AGC Automatic gain control (maintains volume)

ALS Ambient light sensor

AMSL After Market Service Leader

ARM Advanced RISC Machines

ARPU Average revenue per user (per month or per year)

ASIC Application Specific Integrated Circuit

ASIP Application Specific Interface Protector

B2B Board to board, connector between PWB and UI board

BA Board Assembly

BB Baseband

BC02 Bluetooth module made by CSR

BIQUAD Bi-quadratic (type of filter function)

BSI Battery Size Indicator

BT Bluetooth

CBus MCU controlled serial bus connected to UPP_WD2, UEME and Zocus

CCP Compact Camera Port

CDMA Code division multiple access

CDSP Cellular DSP (expected to run at low levels)

CLDC Connected limited device configuration

CMOS Complimentary metal-oxide semiconductor circuit (low power consumption)

COF Chip on Foil

COG Chip on Glass

CPU Central Processing Unit

CSD Circuit-switched data

CSR Cambridge silicon radio

CSTN Colour Super Twisted Nematic

CTSI Clock Timing Sleep and interrupt block of Tiku

CW Continuous wave

D/A-converter Digital-to-analogue converter

DAC Digital-to-analogue converter

DBI Digital Battery Interface

DBus DSP controlled serial bus connected between UPP_WD2 and Helgo
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DCT-4 Digital Core Technology

DMA Direct memory access

DP Data Package

DPLL Digital Phase Locked Loop

DSP Digital Signal Processor

DTM Dual Transfer Mode

DtoS Differential to Single ended

EDGE Enhanced data rates for global/GSM evolution

EGSM Extended GSM

EM Energy management

EMC Electromagnetic compatibility

EMI Electromagnetic interference

ESD Electrostatic discharge

FCI Functional cover interface

FPS Flash Programming Tool

FR Full rate

FSTN Film compensated super twisted nematic

GMSK Gaussian Minimum Shift Keying

GND Ground, conductive mass

GPIB General-purpose interface bus

GPRS General Packet Radio Service

GSM Group Special Mobile/Global System for Mobile communication

HSDPA High-speed downlink packet access

HF Hands free

HFCM Handsfree Common

HS Handset

HSCSD High speed circuit switched data (data transmission connection faster than GSM)

HW Hardware

I/O Input/Output

IBAT Battery current

IC Integrated circuit

ICHAR Charger current

IF Interface

IHF Integrated hands free

IMEI International Mobile Equipment Identity

IR Infrared

RM-495; RM-496
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IrDA Infrared Data Association

ISA Intelligent software architecture

JPEG/JPG Joint Photographic Experts Group

LCD Liquid Crystal Display

LDO Low Drop Out

LED Light-emitting diode

LPRF Low Power Radio Frequency

MCU Micro Controller Unit (microprocessor)

MCU Multiport control unit

MIC, mic Microphone

MIDP Mobile Information Device Profile

MIN Mobile identification number

MIPS Million instructions per second

MMC Multimedia card

MMS Multimedia messaging service

MTP Multipoint-to-point connection

NFC Near field communication

NTC Negative temperature coefficient, temperature sensitive resistor used as a
temperature sensor

OMA Object management architecture

OMAP Operations, maintenance, and administration part

Opamp Operational Amplifier

PA Power amplifier

PDA Pocket Data Application

PDA Personal digital assistant

PDRAM Program/Data RAM (on chip in Tiku)

Phoenix Software tool of DCT4.x and BB5

PIM Personal Information Management

PLL Phase locked loop

PM (Phone) Permanent memory

PUP General Purpose IO (PIO), USARTS and Pulse Width Modulators

PURX Power-up reset

PWB Printed Wiring Board

PWM Pulse width modulation

RC-filter Resistance-Capacitance filter

RF Radio Frequency

RM-495; RM-496
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RF PopPort™ Reduced function PopPort™ interface

RFBUS Serial control Bus For RF

RSK Right Soft Key

RS-MMC Reduced size Multimedia Card

RSS Web content Syndication Format

RSSI Receiving signal strength indicator

RST Reset Switch

RTC Real Time Clock (provides date and time)

RX Radio Receiver

SARAM Single Access RAM

SAW filter Surface Acoustic Wave filter

SDRAM Synchronous Dynamic Random Access Memory

SID Security ID

SIM Subscriber Identity Module

SMPS Switched Mode Power Supply

SNR Signal-to-noise ratio

SPR Standard Product requirements

SRAM Static random access memory

STI Serial Trace Interface

SW Software

SWIM Subscriber/Wallet Identification Module

TCP/IP Transmission control protocol/Internet protocol

TCXO Temperature controlled Oscillator

Tiku Finnish for Chip, Successor of the UPP

TX Radio Transmitter

UART Universal asynchronous receiver/transmitter

UEME Universal Energy Management chip (Enhanced version)

UEMEK See UEME

UI User Interface

UPnP Universal Plug and Play

UPP Universal Phone Processor

UPP_WD2 Communicator version of DCT4 system ASIC

USB Universal Serial Bus

VBAT Battery voltage

VCHAR Charger voltage

VCO Voltage controlled oscillator

RM-495; RM-496
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VCTCXO Voltage Controlled Temperature Compensated Crystal Oscillator

VCXO Voltage Controlled Crystal Oscillator

VF View Finder

Vp-p Peak-to-peak voltage

VSIM SIM voltage

WAP Wireless application protocol

WCDMA Wideband code division multiple access

WD Watchdog

WLAN Wireless local area network

XHTML Extensible hypertext markup language

Zocus Current sensor (used to monitor the current flow to and from the battery)

RM-495; RM-496
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